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Embroidery Essentials Webinar 17

Day 1

Welcome to our Embroidery Essentials Webinar. Today’s webinar will use a combination of written instructions as well as visual
demonstrations. This document contains all the information that will be covered in detail.

It takes more than a great machine to produce great embroidery. There are several factors that go into the process, including
proper thread tensions, the right needle, appropriate backing, hooping techniques, quality design creation setup, proper software
settings, etc. We will learn all of these variables, what they are and how they interact. We categorize these variables into what we
affectionately call the 3 P’s of Embroidery Perfection.

reparation of the Garment

You will learn how to compensate for the negative characteristics of the garment using Backing, Topping and Needles.

lanning the Design

You will be introduced into the Tajima DG/ML by Pulse software and cover basic design creation as well as elemental

editing files.



Preparation of Garment

I Fabric Characteristics

Understanding Different Materials is perhaps one of the greatest challenges an embroiderer must learn.

The reasons for this are simple:

1 - There will be a variety of fabric types that your customers will ask you to embroider on.

2 — With all the different hooping aids available on the market today, you can embroider on virtually any object!

So, to get you started thinking in the right direction, I've split fabrics into separate categories based off of certain characteristics:
Stretch and Give, Bulk and Thickness and Surface Texture.

[ |
I Stretch and Give
e Knit Garments ¢ Woven Garments
¢ Tee Shirts o Twill
* Fleece e Denim
e Sweaters ¢ Non-Woven Garments
¢ Pique Polo Shirts e Felt
e Terry Cloth
e Leather
e Suede

Any type of knit garment will stretch and give even when the garment is hooped. This is because of the fibers used and also how
those fibers were woven together.

After the training today, pick up a tee shirt that you have and gently tug the garment by pulling your hands apart. Notice how easy it
is to stretch.

Woven Fabrics and Non —woven fabrics are very stable because they do not stretch and give.
Again, pick up a denim shirt or a leather jacket and gently tug the garment by pulling your hands apart. Notice that the fabric
doesn’t stretch and resists the pull.



I Bulk and Thickness:

Thick/Bulky Garments Thin Garments

* Fleece e Tee Shirts
e Towels e Linen

* Blankets e Cotton

e Sweaters e Silk

e Wool e Satin

e Faux Fur

Thick / bulky fabrics are generally soft and allow the stitches to sink into the material. The result will affect the overall coverage of
your stitches and in some cases, cause the stitching to shift on the pile of the fabric.

With thin garments, great care is taken to ensure that there aren’t too many stitches to eat the fabric up causing puckering around
the design, birdnests or runs in the fabric.

’i Surface Texture:
e Tee Shirts ¢ Fleece
e Linen e Towels
e Cotton e Sweaters
e Silk ¢ Pique
e Satin e Faux Fur
e Leather e Wool
e Suede e Felt
e Denim e Terry Cloth
o Twill

A smooth unbroken surface provides a stable platform for the stitches to sew on.

A fabric that has a rough surface texture will cause the stitches to lie somewhat haphazardly on Some of the fabrics are included in
multiple groups. Careful attention
should be paid to ensure good quality
embroidery.

the fabric, causing the edges of letters to look uneven and jagged.



I Backing

Now, that we’ve explored the negative characteristics of fabrics, let’s discuss how we can compensate the fabric.

One of the most important items to consider is Backing. Backing or stabilizer is a fabric material that is placed behind the garment
and hooped with it. Backing material is very stable and won’t shift or stretch during the hooping process or even the sewing process.
During the sewing process, the backing material is attached by the stitches thus transferring the stable characteristics to the
garment and anchoring the fabric in place.

Backings also improve detail stitching.

There are basically 2 groups of backing to choose from — cutaway and tearaway. Both styles come in different weights, colors and
sizes. The difference comes from its function.

I Cutaway Backing
|

Sample Fabrics to use Cutaway Backing

e Tee Shirts
e Sweatshrits
e Sweaters
® Pigue Polo Shirts
¢ Spandex - including fabrics with cotton/spandex blend
e Underarmour/ Moisture wicking shirts

Cutaway Backing is typically a non woven material and cannot be torn. Therefore, it is permanently attached to the garment during
the sewing process. This provides the best stability to your garment and thus should be used on unstable garments. Once the
garment is laundered, the cutaway backing will soften considerably, much like a dryer sheet.

How to use it
When using Cutaway backing, you will choose a piece larger than the hoop you will use. Place it under the garment and hoop it with
the garment.

How to remove it
Once the sewing process is completed, you will cut away any excess backing, leaving approximately .25” around the design.
You will need to take care that you do not cut into the actual garment while cutting the excess backing and you can round any sharp

corners to give a smooth corner.

To ensure that you do not cut
into the garment when you are
removing the backing — turn the

shirt inside out.



I Tearaway

Sample Fabrics to use Tearaway Backing

e Blankets
e Towels

e Leather
e Suede
e Caps
* Bags
e Denim
e Twill

Tearaway is typically a paper type material and can be “torn” away from the garment, so the stable characteristics of this backing is
only temporarily applied. Therefore, the fabrics that you apply tearaway backing should be stable enough to hold the stitching after
the backing is torn away. It is most commonly used for fabrics where the back of the embroidery design will be seen.

How to use it
When using Tearaway backing, you will choose a piece larger than the hoop you will use. Place it under the garment and hoop it
with the garment.

How to remove it
. . - . . Tear in the opposite direction of the
Once the sewing process is completed, you will simply tearaway it away from the item. a ' ol ' — .
stitches of a design that contains
long satin stitches. This will keep
the stitching from pulling with the

backing.

I Specialty Backings

No Show Polymesh Peel 'n Stick

e Light Colored Garments e Caps
e Spandex * Bags
e Underarmour

* Moisture Wicking Garments

We also have specialty backings available for those really specific applications: No — Show Polymesh and Adhesive Backing.



No Show Polymesh

Use the No Show for garments that need a Cutaway backing, but you don’t want to see the outline through the garment. One of the
rapidly growing uses of the no show backing is on the 100 % polyester or moisture wicking garments. These garments are very much
like spandex and that they will stretch whichever way and no matter what type of backing you use. But, with the No Show
Polymesh, you can iron the backing from the inside of the shirt and it will smooth the wrinkling around the embroidery design.

How to use it
Make sure to use a damp paper When using No Show Polymesh backing, you will choose a piece larger than the hoop you will use.

towel or wax paper between the Place it under the garment and hoop it with the garment.
iron'and the backing. This will

ensure that you do not burn the

polyester material. How to remove it

Once the sewing process is completed, you will cut away any excess backing, leaving approximately
.25 ” around the design.
You will need to take care that you do not cut into the actual garment while cutting the excess backing
and you can round any sharp corners to give a smooth corner.

Peel ‘n Stick

The Peel N Stick backing is a form of tearaway backing and is especially popular for bags. It is used primarily on the clamping
systems or the quick change frames. Just remember that it does have an adhesive side and therefore it is not recommended for
garments with nap. It may accidentally leave a bare spot.

How to use it

When using Peel ‘n Stick backing, you will choose a piece larger than the hoop and place it under the garment and hoop; or if you
are using it with your clamping system, you will choose a piece larger than the window you want to use. Place the sticky side face up
and then press the garment into the sticky backing.

How to remove it

Tear away any excess backing just as you would for regular tearaway backing.
Because it has an adhesive side,
it is not recommended on fabrics
with nap or loose fibers. It may
accidentally leave a bare spot on
the fabric.



I Backing Guidelines

Choosing A Weight

e Thick/bulky garments require heavier weight backing

e High stitch count designs require heavier backing

e Thin fabrics require light weight backing

e Low stitch count designs require lighter weight backing

Choosing Sizes

* Backing can be purchased precut or by the yard.
e If you find that you embroider mostly left chest size designs, go with the precut backing to
save you time cutting.

¢ |f you do many different size embroidery designs and different applications, you will benefit
from cutting your own backing to fit your design size. Stay away from trying to piece
together backings. This truly defeats the purpose of using a backing at all.




I Toppings

Sample Fabrics to use Toppings

¢ Cordoroy

¢ Pique Polo Shirts

e Scultured Knits

e Large Twills

¢ Terry Cloth

* Towels

e Fleece

* Velvet

e Faux Fur

¢ Fluffy Materials
Topping is a special material — usually water soluble that is placed on top of your garment before being hooped. It looks very much
like plastic kitchen wrap but is not clingy and will melt when it is wet. You use toppings to prevent the edges of your design from
sinking into the material by offering a flat surface for your stitches to sew on.

After the sewing process, un-hoop the garment and tearaway as much as you can of the topping. You can use a steamer or a misting
bottle to get the remaining topping damp, then use the topping that you ripped off earlier and blot at the garment. The remaining
topping will lift right off the garment. Take care that you don’t rub. The topping becomes very gluey and will smear across the

garment if you rub.

How to use it
Place the topping on top of the garment and then hoop it. Embroider your design as usual.

How to remove water soluble topping
After you un — hoop your garment, tear off as much of the topping as you can. Then use a spray bottle with water and mist it lightly

or steam for a couple of seconds. Take what you’ve ripped off and bloat at the remaining pieces. It will lift right off the garment.

How to remove melt away topping
After you un — hoop your garment, lay a paper towel on top of the melt away. Iron on medium setting with no steam or water until

the melt away becomes little flakes. Then simply brush them off the garment.

10/Page



I Needles

Needle Size Needle Point System Number

*Needle Size denotes the *Sharp eDenotes size of needle and
diameter of the blade or *Ball size of the eye
shaft. oWedge

Another important item to consider when compensating for these fabric characteristics are needles. There are several different
variables to consider when selecting a needle: application, current needle size in use, thread type and weight and needle eye size.
A needle has 3 defining characteristics: needle size, needle point, and system number.

Needle Size

Needles size denotes the diameter of the blade or shaft. The size that you would select to use is dependent upon the thick/stiffness
of the fabric as well as the thread weight. In general, the larger the needle the larger the eye.

The larger the needle size, the larger the blade and hole made in your fabric. The result is a stronger needle.

For heavy, stiff fabrics, a larger size needle should be selected.

For lightweight fabrics, a smaller needle can be used.

Needle Point
SHARP: Typically used for tightly woven fabrics, such as denim, twill, towels or corduroy. As the needle passes through the fabric, it
may actually cut fibers. However, since these garments are tightly woven, this is generally not a

problem.

BALL: Typically used for knit goods, fleece and delicate fabrics. The tip of this needle is smoothed so 75/11 Ballpoint
that when it passes through the garment it will push the fibers aside, allowing the fibers to close back Needles come
around the thread. standard in all Tajima

Machines.
WEDGE: Typically used for tough non — woven fabrics, such as leather. It cuts as it passes through the
fabric and reduces friction.

Needle System Point
Another descriptive term for needles, it is a combination of numbers and/or letters referring to the total length of the blade and size
of the needle eye.

DBxK5 — Standard for commercial embroidery machines.

DBx7ST — Has a larger eye that is elongated and rectangular in shape. Most common use is with metallic threads.

DBx9ST — Needle eye is twice the size of the DBxK5 and is useful for heavy embroidery threads.



Below is a recommendation chart for choosing the most appropriate needle for the fabric that you will be embroidering.

Needle Recommendation Chart

FABRIC/IGARMENT NEEDLE SIZE NEEDLE POINT
Canvas 8012 Sharp point

Coated or Waterproof Fabrics a80/12 Sharp or light ball peoint
Corduroy 7511 Sharp or ball point
Caotton Sheeting 70/10 to 80/12 Sharp point

Denim 7511 Sharp point

Dress Shirt (woven) 70/10 to 80/12 Ball point

Golf Shirt (Knit) 70/10 to 80/12 Ball point

Lace 7511 Sharp point

Leather a0/12 Sharp or wedge point
Lingerie and Silk 60/8 to 7511 Sharp or light ball point
Lycra or Spandex 70/10 to B0/M12 IMedium ball point
Nylon Windhreaker 70/10 to 80/12 Light ball point
Organza 659 Ball point

Rayon 7511 Ball paint

Satin Jacket 7511 Sharp point

Sweater 7511 Sharp point
Sweatshirt 70/10 to 8012 Light ball point
Taffeta G659 Ball point

Terry Clath Towels 7511 Sharp or ball point
Velvet 65/9 Ball point

Vinyl 7511 Sharp peint

Now, that we’ve explored all the variables that contribute to garments, let’ put it all together.

Here are some samples of what you would use for different garments.

{Backing}

Tearaway 3.0 oz

{Topping}

N/A

{Garment Name} | CAP
& - 3%
&
{Placement} | FRONT
) 75/11 DBxK5 {Design Max Size}
{Needle Information} .
Sharp Point

WIDTH: 12.50 inches

HEIGHT: 2.25 inches




{Garment Name}

Shirt: Tee Shirt, Polo, Sweatshirt,
Placket, etc.

{Placement} | Left Chest
. 75/11 DBxK5 {Design Max Size}
{Needle Information} .
Ball Point

Cutaway 2.5 oz

{Backing} | (can substitute with 2 ply 1.0 0z No
Show Polymesh)
{Topping} | N/A (unless loosely woven)

WIDTH: 4.00 inches

HEIGHT: 4.00 inches

{Garment Name}

Towel: Hand, Finger, Bath

Front Bottomed Centered

{Placement} <or>
Caddy Cornered
. 75/11 DBxK5 {Design Max Size}
{Needle Information} .
Sharp Point

{Backing}

Tearaway 2.0 oz

{Topping}

Melt Away

WIDTH and HEIGHT: choose most appropriate for size and
location of design




Sweatshirt ﬁ‘*ﬁi&
{Garment Name} | <or> -~
Jacket
K
{Placement} | Back Centered :
75/11 DBxK5 Design Max Size
{Needle Information} / ] t & I
Ball Point

WIDTH and HEIGHT: choose most appropriate for size and

{Backing} | Cutaway 2.0—2.50z
location of design
{Topping} | N/A
Sweatshirt
{GarmentName} | <or>
Jacket
{Placement} | Front Centered
. 75/11 DBxK5 {Design Max Size}
{Needle Information} ]
Ball Point

{Backing}

Cutaway 2.0—-2.50z

{Topping}

N/A

WIDTH or HEIGHT: choose most appropriate for size and
location of design




Introduction
Thank you for purchasing the Tajima DG17 embroidery software solution. This is the latest
in embroidery creation technology brought to you by Tajima Software solutions.

This document outlines the major differences between Tajima DG17 and the previous
version. It is intended to be used in combination with the program user’s guide or the online
help. You can also access documentation under the Help menu or by pressing F1 key from
within the program.

Tajima DG17 has many new features; note that some features may only be available in
specific levels of the software.

Recommended Systems Requirements:

Below is a list of the recommended computer specifications if you plan to purchase a
computer for Tajima DG17.
« PC with 64-bit 3.0 GHz Quad Core Genuine Intel Processor
« Microsoft Windows® 10 or Windows® 11 operating system (64-bit)
« 16 GB RAM
e 4 GB hard disk drive space available
» Mouse
» At least one Universal Serial Bus (USB) port (for attaching the security device)
« A LAN (Local Area Network) connection
Minimum system requirements:

» PC with a 64-bit 2.5 GHz (or faster) Quad Core Genuine Intel processor

» Microsoft® Windows® 10 or Windows® 11 operating system (64-bit)

» 4 GB RAM

« 1 GB hard disk drive space

« Mouse

e At least one Universal Serial Bus (USB) port (for attaching the security device)

e A LAN (Local Area Network) connection
Additionally, an internet connection required for access to PulseCloud services.
Important note for Windows 11 "Home" edition users: As installed, Windows 11
Home edition will be in "S" mode by default. In this mode, you are only allowed to install

software that comes from the Microsoft store, so you will not be able to install Tajima DG17.
To switch out of "S"” mode, do the following:

« Open the Microsoft Store and navigate to the "Switch out of S mode” page.

» On this page, select "Get". Once you see a confirmation notification from the
Microsoft store, you will be able to install DG17.



1.3 New Installation Options -Units, Fonts, and Density Setting

A new page has been added to the Tajima DG17 installation procedure. On this new
installation page, you can decide which of the following will be the default behavior in the
software:

» Units: Select either metric (mm) or Imperial (inches)

» Fonts: Hide old fonts (so that only new-style fonts will appear) or use both old and
new style fonts.

+« Density: Choose how the stitch density will be displayed - either absolute density or
relative density (with relative density, the density is expressed relative to a set
default density value).

Planning the Design

This section will focus on how to plan and create basic embroidery designs. We will start with an introduction into the software and

then cover the essential tools you will use regularly to create such designs as namedrop, monogram, name — stacking and templates.

User Interface Changes

New Ribbon Interface

The ribbon is a new innovation of the Tajima DG17 workspace. The Ribbon appears along the top of the
workspace. This area includes a number of different tabs, which take the place of the menus in former
versions of DG by Pulse. The Ribbon is turned on by default; to turn it off and use the conventional menus and
properties panel, go to Tools—User Settings—Environment—Display, and uncheck “Use ribbon interface.”

For example, there is a tab listing all the File functions, one for Manage functions, and another for Librarian
tools.
WIEW FANAGE TOOLS LIBRARIAM PROCESSING GEMERATIOMN SEGMENT AUTO IMAGE HOOP HELP
r Open Design... E Save As Design... ﬂf’ View Favorites... wwd Database Properties.. a) Rebuild lcons

[+]
Q Search... r‘ Import - X Switch to Remote [Multius...

H Save Design .G Groups...

Librarian

There also tabs for Tools, Processing, Generation, Segment, Auto, Image, and Hoop.

The Ribbon is also context-sensitive, which is to say, the tabs that appear there will change depending on
what kind of segment is selected. For example, whenever a new file is opened, the Design Properties tab will
appear on the ribbon.

FILE VIEW MANAGE TOOLS LIERARIAN PROCESSING GEMERATION SEGMENT AUTO IMAGE HOOP HELP DESIGMN PROPERTIES

Height: 31.2 mm . Frame Position * Hoop Selection .
Master Density: |0.40 mm Recipe: Marmal
Width: 90,7 mm Mone Type: Auto Clamp Frame
Fabric Thickness:| 0.5 mm . Preset Set:|Basics
Percentage: | 100.0 % Name: ACFA-150X130
Resize Properties Design Start Position Recipe/Preset

Then, when a segment is added and selected, the Properties tab will open, and show the properties particular
for that segment. So, if an artwork shape is selected (for example) the Ribbon shows only those properties
that apply to artwork segments.



Tajima DG16 by Pulse - Designi

w MAMAGE TOOLS LIERARIAN PROCESSING GEMERATION SEGMENT AUTO IMAGE HOOP HELF
-
Hsam [wox| O FPEHE HEOF OO
o 1]
i W = =
T ot T 4 WX *:@aa
Resize Rotate Alignment Edit Tools Shape

Then, if Text is selected, you will see a different set of settings.

DESIGN

DESIGN PROPERTIES ARTWORK

Artwork N Basic

- APXF DESIGN
N SEGMENT AUTO IMAGE HOOP HELP DESIGM PROPERTIES TEXT
25 Bl Fectangle v | | ——— Free Line = | |Closest point
Text: | ABC MNew embroidery f -
2 ARC centre - | ABC Upper -| 30mm

Text

= | [Trim

Pull comp: Advanced
Always

[ Compensation [

Similarly, the contents of the ribbon will change for all segment type - whether it be a fill, cross-stitch, or any

other.

Toolbar Reorganization

The Tajima DG17 by Pulse toolbars have been re-organized to improve clarity. Many of them have been
changed to work as “fly-out” toolbars - that is, you click on the toolbar to open all the tools that it contains
(see example below). This change has been made to simplify the workspace view when many toolbars are

open.

f;.‘ -‘:;_ Vertex Select M
 —

Edit Envelope

Copy Partial Path

a‘ |—” Rounded Corner Tool

. ; Drag Anchor Path

F Average anchor harizontally
Average anchor vertically

Erase Cutline

o

’;
-FF+ Add Anchor Point Shift=M
I

b 4

Example of a “fly-out” toolbar — in this case, the Node Edit tools.

As well, the artwork for most of the tool icons has been updated.



1.1 Toolbar “Expand Mode”

New functionality has been added to the fly-out toolbars, which will improve your ability to
view and select tools easily. Clicking on any one of these toolbars (e.g., Text, Path Edit,
Standard Digitizing, etc.) for an extended time (anything over one second) will turn on the
“expand on hover” mode. In this mode, you only have to move the mouse over any other
toolbar to expand it, so that all the tools it contains become visible. You can then click to
select any tool on the expanded toolbar in the usual way.

€( a Angle Lines D
. ;
‘g Virtual Slice U
@4 @ Density Line
e
% Sy Stitch Length
- =
4| BF .
= Variable Width
g8 @ w-
“

Product level availability: All

User Settings

Customize & Restore Recommended Settings

The Tools menu now has a “"Restore Recommended Settings” option. This allows the user to restore the
settings in the “User Settings” dialog to the defaults, if they have been altered. To personalize the user
settings, go to Tools—Configuration—User Settings—Customize...

Product level availability: All

Highlight color overrides

There are two new options for how tools will be highlighted when digitizing - “Override Tool Color” and
“Override Tool Highlight Color.”

e The Override Tool Color setting allows you to choose the color that will be used for the anchors and
lines of a segment as it is digitized with any digitizing tools.

e The Override tool highlight Color setting allows you to choose the color that will be used to highlight
control points (e.g., the “handles” that are used to control the shape of Bezier curves) when you select
them with the vertex select tool.

These color overrides may be implemented in the User Settings. Go to Tools—Configuration—User Settings—
Customize—Environment—Display colors; these overrides are found in Tools area of the Display Colors page.



I Start Page

When you start up the Tajima DG17 by Pulse software, you can immediately begin creating your design. As with any software

program, you can start a new file and create it from scratch or you can open an existing design — one that you purchased from an
internet stock design distributor or from a digitizer.

B vewne
B Oven file

%) 27.08T

010 Numbers. x5

%) 16.08T

%) 13.08T

pulse![i] Bopiy

Increase your orders and profitability.
Offer personalized products to a global market.
CCONTACT YOUR PULSE DISTRIBUTOR TO FIND OUT HOW!

Reporting With Enterprise Networking

Enterprise networking solutions are equipped with operator login and logout functions that will track operator machine usage using barcode
technology. Operators can login to their embroidery machines by scanning their operator ID, directly into the control panel of the embroidery
machine and their production is monitored throughout their shift

An Operator Summary Report is produced that includes number of stitches, number of runs, operator login and logout times, number of
resews, a list of jobs processed by the operator, and other production statistics. This ensures that your operators are motivated to hit their
numbers and you can be sure that you are getting the best productivity possible.

In addition to operator efficiency, you can gain great insight into the functionality of your machines. Reports can be generated on machine
production including running time, down time, pieces produced per hour and total production. The Machine Summary Report contains
information such as total running time, total down time, total stitches produced, number of runs, number of pieces produced, stitches per
hour, a list of completed jobs, and other production statistics. Monitor each and every detail of your machines and your production fioor.

Make informed decisions for machine and operator planning with data sent directly from the embroidery machines. There is no need to rely
on manually created production reports that are time consuming and prone to error. This information enables production managers to better
plan their production schedule and quickly respond to production issues.

Reporting statistics for operators and machines can be saved as XLS reports or through an remotely
over the internet with up to the minute information. Since reporting is available online, it is accessible from any PC or tablet on your corporate
intranet using a modern web browser.

If you operate a large organization, an effective enterprise networking solution is essential in maximizing productivity and increasing
profitability. It is important to choose an enterprise networking solution with a reputation for quality and consistency.

If you are ready to automate your apparel decoration business or are curious to learn more, please contact your local Pulse Microsystems
or visit www. icro. L

[EMBROIDERY DTG PRINT

ENGRAVING

Latest posts

User manual for PULSE DG 16
lllustrator Extreme
91 days - from roman@galax sk

Pulse fonts and true type fonts

95 days - from lynx29
Update 16.5.2.7640
istenSabalis

Script Errors for PulseCloud on
New Computer

117 days - from CrazyFrog

Does anyone know about this

feature?
129 days - from KIYOONBAEK

Training video of the
day

Complex Satin Segment



I Creating a New File

If you choose to start a new file and create from scratch, you have the option of choosing a Blank Design or using the New Design

Wizard.

To create a new file:
1. Do one of the following:
a. From the Start Page, choose
New file...

B New file...

b. Choose File — New.

c. In the File toolbar, click the

New Page tool D .
d. Press Ctrl+ N.

2. Ifyou choose Blank Design, the Normal R

Embroidery

[N
Blank Design

Wizards
\Q» Autodigitizer

Specialty Projects

‘@ Patches

& News Design Wizard
@ Stitch Image

|—|ﬁi Templates

Creates a new design using default setiings

Recipe: Normal

Machine Format Tajima
Preset None

Start/Stop Location: Center

3. Ifyou choose New Design Wizard, you will be guided through choosing a recipe and settings for the design.

a. First you will choose a Recipe.

Recipes are a collection of fabric types that contain preprogrammed settings based on the size of the design. These settings include

density, pull compensation and underlay. These 3 settings are called Stitch Control Factors and will need to be adjusted for every

different type of fabric.

DENSITY: refers to the amount of stitch coverage over a given area.
PULL COMPENSATION: an adjustment of the stitch length to compensate for the pull of the stitches on the fabric
UNDERLAY: the preliminary stitches that sew prior to and underneath your design creating a foundation for the top stitches to lay on

The complete list of recipes includes:

- Baby Blankets
- Canvas

-  Cap

- DogCollar

- Fake Fur

- Fleece

- Global

- Jeans

- Leather

Lycra

Normal (default)
Pique

Pullover

Satin

Shirtcuff

Silk

Sweatshirt
T-Shirt

Towel

Velvet

Vinyl

Woven Fabrics

When in doubt of
which Recipe to use,
try the Woven
Fabrics.




b. Then you will choose a Machine Format.

[Tajima

Barudan
Barudan DST
Barudan Z
Brother
Happy
Happy DST
Melco

Pfaff
Renaissance
SWE

Tajima Chenille ;
Tajima Shuttle Hook

Tajima TEF

Tajima TMCE-100 Chenille
Tajima TMLH

Toyota

Z5K

Z5K Transport

[Nane

Basics

(@) Positioned in the center of the design

(7 Positioned with the first and last stitches

" the end stitch with the last stitch

= Position the beginning stitch at the center of the design and

later.

Finish the design

This set of design settings can be saved as a favorite and reused at a later time.

[] save as a favorite

This set of design settings can be used as the defaults for blank designs or default

values in this wizard.

["] save as default

Click the Finish button to create your new design.

At any time you can
choose to finish and exit
the Design Wizard.

Next, you will choose if you want a preset on the punching tools. This is only applicable in Creator, lllustrator
Extreme and Maestro Multimedia levels of Tajima DG/ML by Pulse.

Then, you will choose the design’s start and stop location. This should always be set to “positioned in the center of
the design” unless you are digitizing the design differently.

Lastly, you will have the option of savings your set as a favorite or a default that you can select quickly for reuse



I Changing the Units from Metric to Inches

By default when you install the Tajima DG/ML by Pulse software onto your computer, it sets the measurements as metric.

1. To change this to inches, go to Tools > Configuration > User Settings > Units.

2. Click OK.

ra B -— ™
p— T S WA B

----- & General

-5 Environment
----- (7 File Locations
----- ¥ Fill Patterns
(& Print

lsi Units

Units of measurement

() Metric (mm)

(@ Imperial (inch)
% Melco Condensed

----- # Stitch Generation

----- «» Drawing

..... &

----- [# Draw Fusion

----- II Thread Charts

----- £ File Associations

- Performance

Units of density
() Millimeters
() Points

(©) Stitches per inch (SPI)

Embroidery setting units
-@'Millimeters
(") Points

_lInches

["]Absolute density

3. For the changes to take effect, you must close the window and open a new one

4. When the new window opens, it will look large. You
have to reset the grid to inches as well.

5. Right click on the ruler at the TOP or the LEFT side of the
WORKSPACE. You will see the Grid Settings box pop up.

6. Change the Horizontal and Vertical Spacing to 1.00 in
and you can choose the color you want it to show up on
the screen as.

7. Click OK.
These changes will immediately be applied and do not

require opening a new window.

Minor grid
Horizontal spacing:
Vertical spacing: [1.0001in Y
P
Color: - I i
Major grid
Highlight every:
¥ i
Horizontal: |1 lines =
Vertical: 1 lines
-
Grid style DSﬂapto grid
©) Solid lines Snap style
(I Dashed lines Cormner
() Dots Center




I Files of Type - Data Files

In embroidery, we work with two groups of files — outline and stitch.

OUTLINE  STITCH

The outline file contains the framework — outline — of your design. If we take the outline file and resize it, our stitch count increases
and vice versa. The stitches we see on our screen are a simulation of the actual stitches.

There are 4 different outline format files that Tajima DG/ML by Pulse will read:

.PED KWK .CND .PXF

Stitch Files

The stitch file contains fixed in placed stitches. If we

. " . . . Fil ; b 0
resize this file, it will take the same number of stitches & name | J \&l
Files of type: |F'u|se Ernbraidery Files [* FF) - Cancel

and stretch them over a larger area or compress the same — -

. . . . ‘ulze Embraidery Fi 2F]
number of stitches into a smaller area thus resulting in Outling Files [* POF * PED * KwK)

. . Stitch Files [*.PSF * PCH)

poor sewing quality. Elna Stitch File [ EMD)

Taijima Stitch files [*D5ST)
dw Taijima TEF files [*. TBF]
wilcom EME Files [“EME]
Berina ART Filez [*ART)

order to sew your design. Every stitch is placed on a (X, Y) g:gﬁ:gﬁtiggm:g:ig:g:ﬂg {EE% 3z

This is the command file that the machine must have in

graph and has a coordinate number. We take this file to
the machine and line up our needle to the middle of the

hoop setting our (0, 0). The machine will then read and move your frame to begin sewing your design at the (X, Y) number per stitch
in the correct location.

For every embroidery machine on the market today, there is a specific stitch file. There are over 20 different stitch format files that
Tajima DG/ML by Pulse will read.

.PSH .PCH .DST ART JEF .EXP



I Stitch Types

A segment is a single section of an outline or stitch file — much like a puzzle piece to the overall design.

In an outline, the segment is composed of one type of stitch. A complete design will have many segments in an outline file.

In a stitch file, the segment is a group of stitches, broken up only by machine commands, color change, trim or origin.

There are 4 basic types of segments that are used for embroidery — run, satin path, complex fill and stitch segment. The run, satin

path and complex fill segments are found in outline files only, as they are really an area with stitch information. They are easily

modified by changing the assigned properties.

Stitch Segments are found in both outline and stitch files. They are fixed — in — place stitches; therefore, the edits made are limited.

Run Stitches: walking stitch that travels along
the outline; defined by stitch length —
distance between 1* needle penetration and
next

*  Min. Stitch Length 0.03in

* Max. Stitch Length 0.20in

Used For:

Fine detail
Underlay
Traveling Route

Satin Path Stitches: zigzag stitch that travels Used For:
from one side of the column to the next; * Lettering
defined by density — number of stitches filling *  Small Areas
in —and column width — the length of the * Thick Borders
stitch, and angle lines — direction of the (Steil)
stitches

* Min. Column Width 0.04 in

*  Max. Column Width 0.50in
Complex Fill Stitches: run stitch that travels Used For:
from one side of the column to the other, * Large Areas
offsetting the stitch lengths to give you a *  Complex
pattern Shapes

No min/max because stitch length is
preprogrammed

Stitch Segments: contains fixed —in — placed

stitches. For this segment, you will have to
edit one stitch or a group of stitches




I Shortcut Keys

Below is a quick reference to the most commonly used keyboard shortcuts. The character in parentheses denotes the actual
keystroke.

Viewing Tools

* (2)=Zoom
Left Click = Zoom In
Right Click = Zoom Out

* (V) = View by Color

(2) = Fit to Window

(Ctrl) + (M) = Measure Tool

* (1)=Backto1l:1 (4) = Fit Selection to Window

+ Display Hoop + Draw Ribbon
« (3)=3D
General Tools
* (G) = Generate Stitches ¢  (SHIFT) + (G) = Generate All
* (S) = Select Tool *+ (CTRL) + (G) = Group Segments
* (CTRL) + (Y) = Redo * (CTRL) + (U) = Ungroup Segments
« (CTRL) + (2) = Undo + (CTRL) + (R) = Resize
+ (CTRL) + (C) = Copy to Clipboard + (CTRL) + (T) = Rotate
+ (CTRL) + (X) = Cut to Clipboard *+ (CTRL) + (F) = Reflect
+ (CTRL) + (P) = Paste from Clipboard




I Text - Creation

Creating lettering and text is perhaps the most common function that you will perform. You can create a variety of lettering “looks”
and layouts by using the various lettering tools in your software. Each lettering tool creates a unique platform or baseline that the
text will sit on.

There are six different lettering tools in the Tajima DG/ML by Pulse software as follows:

Line Angle

Line Vertical

Arc

Circle

Three Letter Monogram
Text

I ol A

The Line Angle, Line Vertical, Arc, Circle and 3 Letter Monogram Tools all use a box type baseline which creates single or multiple
lines of text horizontally or vertically. The Text Tool creates a free style baseline for the lettering.

I Line Angle

To Create Text Using the Line Angle Tool:

- Left click once on the workspace to start the baseline

- Move the mouse across to set the length of the baseline (you will see the length and angle that you are drawing next to
your line); drag down if you wish the lettering to be at an angle

- Leftclick to confirm the length angle

- Move the mouse up to set the height of the lettering (you will see the height next to the line that you are drawing)

- Left click to confirm the height

- The Text Box appears —type in the desired text.

- Click OK.



I Line Vertical
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To Create Text Using the Line Vertical Tool:

- Left click once on the workspace to start the baseline

- Move the mouse across to set the length of the baseline (you will see the length and angle that you are drawing next to
your line); drag down if you wish the lettering to be at an angle

- Left click to confirm the length and angle

- Move the mouse up to set the height of the lettering (you will see the height next to the line that you are drawing)

- Leftclick to confirm the height

- The Text Box appears — type in the desired text.

- Click OK.

To Create Text Using the Arc Tool:

- Left click once on the workspace to start the baseline

- Move the mouse across to set the length of the baseline (you will see the length and angle that you are drawing next to
your line); drag down if you wish the lettering to be at an angle

- Leftclick to confirm the length and angle

- Move the mouse up to set the radius (curvature) of the baseline ( you will see the radius next to the line you are drawing)

- Leftclick to confirm radius

- Move the mouse up to set the height of the lettering (you will see the height next to the line that you are drawing)

- Leftclick to confirm the height

- The Text Box appears —type in the desired text.

- Click OK.



To Edit the Arc Baseline:

- Left and drag one of the four square boxes to edit the shape of the baseline

0

I Circle

Bas
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To Create Text Using the Circle Tool:

- Left click and drag straight up to set the size of the first circle. As soon as you let go of the mouse, the baseline size is
confirmed.

- Move the mouse up to set the height of the lettering. Again, as soon as you let go of the mouse the height is confirmed.

- The Text Box appears —type in the desired text to appear on the top of the circle in the upper text and the desired text to
appear on the bottom of the circle in the bottom text.

- Click OK.



To Edit the Circle Baseline:

- Left and drag one of the four square boxes to edit the shape of the baseline

I Three Letter Monogram

]

- Left click once on the workspace to start the baseline
- Move the mouse across to set the length of the baseline (you will see the length and angle that you are drawing next to

To Create a 3 Letter Monogram:

your line); drag down if you wish the lettering to be at an angle

- Leftclick to confirm the length and angle

- Move the mouse up to set the height of the lettering (the height that you are setting is for the Last initial — the middle
letter)

- Leftclick to confirm the height

- The Text Box appears — type in the desired text: First initial — Last initial — Middle initial.

- Click OK.



To Add a Decoration to a Monogram:

- Choose a Font that has a decoration included (refer to the Font Help Section)
- Typein the keystroke for that particular decoration in the box on the Property Bar
- Hitthe (ENTER) key on the keyboard

gg@%

To Create a 3 Letter Monogram using a Regular Embroidery Font with a Decoration:

- Choose the Three Letter Monogram Tool

- Left click once on the workspace to start the baseline

- Move the mouse across to set the length of the baseline (refer to the Status Bar for exact length); drag down if you wish the
lettering to be at an angle

- Leftclick to confirm the length and angle

- Move the mouse up to set the height of the lettering

- Left click to confirm the height

- The Text Box appears —type in the desired text.

- Click OK.

- Change the font to the desired font.

- Choose the Line Angle Tool

- Leftclick and Right click on the workspace.

- Typeinthe keystroke for the desired decoration

- Leftclick on OK.

- Change the font of the decoration to the corresponding Monogram Font.

- Move it to the desired position in relation to the 3 Letter Monogram



I Text

TEXT BASELINE

To Create a Straight Baseline:

- Left click once on the workspace to start the baseline

- Move the mouse across to set the length of the baseline and hold (SHIFT) to keep it straight
- (ENTER) to complete the baseline

- Typeinyour desired text

- ClickOK

Another way to create a Straight Baseline:

- Left click once on the workspace to start the baseline
- Press (ENTER) to complete the baseline

- Typeinyour desired text

- Click OK

To Create a Curved Baseline:

- Left click once on the workspace to start the baseline

- Move the mouse across to and up

- Leftclick and drag —you will see handles stretch from the point — the further you drag the more
curved the baseline becomes

- Continue until you have the desired baseline

- (ENTER) to complete the baseline

- Typeinyour desired text

- ClickOK

Use BACKSPACE to
delete the previous
point.



TEXT - VERTICAL TEXT TOOL
A Vertical Text Tool has been added.
Tool icon of vertical text tool in text toolbar looks like this é

This tool includes vertical spacing between characters. The default value is 25% of the reference height
of the font.

Spacing type has the following two options

* By line = Using reference height to place the characters on to the base line evenly.
* Fixed = Takes consideration of the height of each character to place the characters on to
baseline so that the space between every two characters is the same

Vertical text can be adjusted using vertical justify, which has four options.
* Top
* Bottom
*  Middle
*  Fit to line

These options compare to left, right, center and fit to curve in the existing text tools.

When selecting vertical text tool, the vertical justify settings will appear on the Ul tab and existing justify
options will not be displayed.

Segment Settings -”? l-. BN B F
4l Basic - —
31 Barder Underlay AN ¥ E - E R
3 Caning Vertical spaang Spacing hpe 4 General
Gl Cormmands 00 % By lnm . Tt PULSE
C Vertical vpacing K%
31 Compensstion
S CUSEO N 0O MTETs Justy: Virtical cpacing fyps ::_-In'ﬁ
a1 Cluality corgrol Top ) :';:t: stify Eu- )
&1 Fun pe .rntlll.'l.'lzry nrris
il Sakin Fort A Block
-} Tt Height 234 mm
Genemn Erveddupe [
i Pt i
~- Autn Shadow Spacing o
Bazsline Teut width 1000 %
Connmcticna Sar ]
~Drop Cap 1
~- Fill anud Buado 4 TTF border
Sew Sequence F -
5 Underlay E
4 Connections
Trim type Trim



I Text - Manipulation

Once you've created your text on your screen, you will want to make slight adjustments to it. This next section will cover how to edit
including spacing, color changes, justification.

Changing Text
[Em?fﬁﬂﬂgs—'] Click in the Text box on the Property Docking Window and type in new

E% %l | & o 'E':? | ';E text. Hit (Enter) to confirm.
A VIS ¥ ex Changing Font
= General - .
Tedt Hirsch — | You can change a font by left clicking o the drop down arrow next to the
Fort type Embroidery forts font name. You have many fonts to choose from including Blocks, Scripts,
Fart . Elock Two Color, etc.
Height 1.00in
Envelope | A preview of the font style will show on ]
Tead justify ARC he right wh h ) he f If the Preview shows
Spacing 0 S the right when the cursor is over the font only CapitalLetters,
Teat width 100.0 % name. that font only has
Slant 0 Capital Letters.
B EreEr There are also some special categories of
Trim type Trim = || fonts: symbol fonts, stitch fonts and
Connection type Closest point regular fonts that have addition special
Trim threshold 0.0mm characters.
Locks Mewver
Texnt lock stitch Li
Test Izzk szh E;h Dljlsmm Image Fonts: will show a design element instead of the keystroke typed.
2 FEill and border Stitch Fonts: are manually created fonts that are to be used at a specific
et outline type Diefault height.
ext outline color change 3D Fonts: are digitized to embroider on top of foam for the puffy look.
Fill type Complex fill 2 Color Fonts: will have two color changes per letter.
= Sew sequence Language Fonts: contain foreign characters — Greek, Hebrew, etc.
eat letter sequence All letters Chan gin Hei ht
Text sew sequence Left
2-colorfort sewing order  Sew by colar Adjust the height proportionally by clicking in the height box on the
E Baseline Property Bar and typing in the desired height. Hit (Enter) key to confirm
Mfaet distanra 0N mm new helght
Font Help

Refer to the Font Help files for vital information on the selected font. It

f]lF‘rcuperties Design Pro... Tool Guide Global View

will show a preview image, available keystrokes, recommended
minimum/maximum height of the font, any special characters the font may have included and suggestions on pull compensation,
sewing etc.

To view the Font Help, click on Help — Fonts. Double click on the Category and choose the desired font style.



I Kerning Beads

. . The cursor must be a
Kerning beads are the little dots on the bottom of each letter. They allow you to manually move

triangle shape before

one letter to a specified spot along the baseline. you can left click and
drag the letter.

You can also Group Space with the Kerning Beads.

Hold the (SHIFT) key to move a particular letter and all the letters to the right of it as a group

anywhere along the baseline.

Hold the (CTRL) key to move a particular letter and all the letters to the left of it as a group anywhere along the baseline.

I Equal Spacing

Spaci 1]
_pau::lng” e (Located on the Properties Docking Window, refer

to Picture on Previous Page)
Theentered spacing

values will be added/
subtracted to any

sl adjustdd This setting is considered equal spacing because of the way it is applied to each character in the font.

s Spacing is determined by units named Em. An Em is equal to 1/20" of the widest letter of the font.
e Input a positive number and the spacing increases between all characters.

e Input a negative number and the spacing decreases between all characters.

I Kerning Arrows

Text Kz<<B>>>RNING N (Located on the Properties Docking

Window, refer to Picture on Previous Page)

Another way to space between individual letters is using the keyboard greater than (>) or less
than (<) in the text box.
Greater Than will increase the spacing, Less Than will decrease the spacing.



I Changing Color

. IB0E00 DT DOnnnE

New Thread Palette/Chart Manager Features

A number of tools and new features have been added to the Thread Palette/Thread Chart manager. These new
features will make it quicker and easier to perform common editing tasks on charts and palettes, such as
inserting threads, deleting threads, changing thread properties, and so on.

e The thread data in each column may now be sorted in ascending or descending order. Click the column
heading once for ascending order; click the column heading a second time for descending order.

e An index column has been added to the thread data, so that the threads can be sorted in chart order.
e Columns for thread thickness and thread type have been added to the data table.

e Multiple threads can selected simultaneously (using the Ctrl+click or Shift+click shortcuts) and then
edited.

In addition, buttons and shortcuts for the following common functions have been added to the Thread Palette
Manager:

e New Thread + (Ctrl+N)
o Insert Thread ™ (Ctrl+I)
o Delete Thread X (Ctrl+D)

e Import Thread ‘ (Ctrl+R)

e Edit thread (Ctrl+E)



I Envelop Text

p— 4
Tend justify B
Spacing [
Text width —
Slant =
EL Connections =
Trim type il
Connection type -y
Trim threshold -
You can change the overall shape of the text using envelopes. The envelopes are a set Locks
of predetermined shapes for the ‘bounding box’ of the text segment. Teat lock stitch type =
Text lock stitch length
To apply an envelope shape: Fill and border =
1. Create the text on your screen. Text outlin type |
Text outling color ch
2. Click on the Envelope in the Properties Docking Window. Fil t)'se . e
3. Then click on the Dropdown Arrow next to the box and choose the desired s
shape.
I Multi - Line Text
Rather than set up each line of text at the same Enter Text 5] | EnterText =]
time, Tajima DG/ML by Pulse has a built — in Multi Enter text: Hirsch .
" International
— Line Text option that you choose from the Text s corp.
Box. Type in as many lines of text needed. Muine | e
To create multiple lines of text: =
|| Split lines into segments
Choose a lettering tool and create the baseline and the height for the text. ok | Canca
When the text box appears, left click on the Multiline option. |

Type in the first line
Hit (Enter) to go to the next line
Repeat as needed until you have all the lines you need.

SN L T

Check the Split lines into segments if desired.
7. Left click ok.
Split lines into segments
When you create multiple lines of text, they are automatically grouped together. Whatever changes that you make to one line will
be made to all the others, unless you check the box to Split lines into segments.
Editing Multiple Lines of Text
If you didn’t choose the Split lines into segments, the only way that you can edit your lettering is if you right click and choose Modify
Text.

Text Justify

With multiple lines of text, you may want to justify or center them. Ye E
Left Justify: will center the text flush on the left side m
Center Justify: will center the text down the middle LB

. . . . . ey
Right Justify: will center the text flush on the right side e
Fill Baseline: will resize the height of the text to fill the baseline BEO

Fill Box: will stretch or compress the height and width of the text so that each
line is the same dimension



¥ Letter Beads

The Letter Bead will allow isolated manipulation to one letter in your text segment

You will want to make sure that the Show Beads is turned on.
Click once on the Letter Bead (donut shape) to activate the editing box

Then, simply left click and drag on the corresponding bead to edit as desired

@ Start Page--"" {.f] Designl x ‘
Turn ON the . . > a ’U
Show Beads

-

"dﬁ&ﬂ

Resize Vertically

CIETIEE e e—

Resize Proportionally

Resize Horizontally

Click once to
activate letter beads,
then you click on it
and you can move
the letter up and
down off the
baseline

/Kerning Bead

©



I True Type Fonts

True Type Fonts are computer generated and are installed on the hard drive of your computer. You can use these fonts in any
software program that uses true type fonts on your computer. Up until this point, we have been working with Embroidery Fonts.

Embroidery Fonts may look exactly like a true type font but they are manually digitized to embroider. They have been push/pull
compensated and guaranteed will sew well. True type fonts may need a little tweaking to get them to sew well.

B General To change from the Embroidery Fonts to the True Type font list: Left click
Text TEAM on the drop down arrow next Font Type in the Properties Panel.
Font type Embroidery fonts '

TrueType® fonts
Embroidery fonts

True Type fonts automatically use a complex fill stitch. Therefore it is very easy to B TTF border

create a two color font or an outline only font. Border A\ . None |
To change the border on the True Type Font: 1l vpe g'ﬁe“
Click on the drop down arrow next to Border and choose one of the following: % Steil only

£%% Color Steil

Steil Border is a satin type segment that outlines the path. You can
adjust the width of the steil to keep the steil border proportional to
the lettering. AN P wOwa aa
Check Scale width if you want the = General

. . . Steil width 0.08 in

steil width to increase or decrease

Steil inset 50.0 %
STEIL STEILONLY  coLOR NONE when you resize the text segment. Steil angle 0
Connection me... Short
Repeat on Steil
Scale width

You can also change the True Type font to appear as an Embroidery font. This will convert the complex fill to a satin path — allowing

the stitches to sew in many different angles, contouring to the shape of the column. The software automatically places slice lines
and angle lines. However, most times, these will need to be edited manually.

= TTF border
To change from Complex Fill to the Satin path, click on the drop down arrow next to Fill Border A None
Type in the Properties Panel and choose satin Path. Fill type Complex fill E

Complex fill




4.2 Action Symbols on the Selection Frame

A new editing feature in Tajima DG17 are the “Action Symbols”, which appear around the
selection frame. Clicking on these symbols gives you instant access to some of the more
commonly-used editing functions, including Delete, Vertex Select, Rotate, Group/ungroup,
and several others. There are also Action Symbols that Lock the selected item(s) from
further editing and to open the right-click menu. (For a complete guide to the function of
the Action Symbols, see the User’s Guide under "Design Editing in Outline Mode—Editing
Segments—Selection Action Tools.”

=
0¢

o

Note that “Action Symbols” are enabled by default; if you want to disable them, open the
User Settings dialog, go the Environment—Display page, and uncheck the "Show action
selection symbols” box.



I Name Stacking With A Spread Sheet

This may look wrong, but can save you a lot of time when having to sew out a long list of names. It is a technique called NAME

STACKING. Name stacking allows you to sew out single lines of text in the same placement but on different garments. Now, instead

of having each name as a single file, you have all names combined into one file. Each name is separated by a color change but is

listed directly on top of each other. The technique is all in how the design is set up.

To create the name stacking:

First you will need to create an excel spreadsheet. Each Column will represent a line. For example, for one line name
designs only have names typed under column A. For 2 line names only have names in Column A and Column B might
be number of title. Save it as xls or xIxs

You will also need to create a PXF file in Pulse with one name or name/number(2 lines)

Once you have those saved:

1)
2)
3)
4)
5)
6)

File New

Click on Patches

Choose the PXF file you wish to work with

Number of Patches will be Number of Names to be stacked

Click Box for Stop Between Patches

For Offset Between Patches, Horizontal Spacing Will Be 0.00 IN, Horizontal Repeats will be number of Names to be
Stacked. Vertical Spacing will be 0.00 IN and Vertical Repeats will be 1

Patch Settings

Design file:

C:\Wsers\fagam0 1\Desktopnames allegra.PXF Lj

Files (Offset Between Patches

Mumber of patches: Horizontal space:

| & 0.001n
+| Stop between patches Horizontal repeats:

Reverse &
Auto text height Vertical space:
Auto resequence by color 0.001in

Vertical repeats:
1

Design Start/End Offset
Horizontal distance (X

0.00in

Vetical distance (Y):
0.00in

Cancel




7) Click Next

8) Click the Import Button and select you spreadsheet. It will populate the list

Design file:

ChUsers\facjam01\Desktophnames allegra.PXF

Mumber of patches:

g =

-

Stop between patches
[] Reverse

[7] Auto text height

[T Auto resequence by color
Offset Between Patches
Haorizontal space:

0.00 in

Horizontal repeats:

6

Design Start/End Offset
Horizontal distance (X):

0,00 in

[ Generate now l

9) Click on Generate now to create the file.

Vertical space:

0.00in

Vertical repeats:

1

Vertical distance (Y):

0,00 in

Text

Jamie
Jamie
Jamie
Jamie
Jamie
Jamie

Font

Allegra Script New
Allegra Script New
Allegra Script New
Allegra Script New
Allegra Script New
Allegra Script New

TIP: Make sure that the longest name fits inside the hoop that you want to use as well as the location on the garment.



Embroidery Machine Operations - TFMX & TEMX Neo Plus Models

The embroidery machine must be
programmed to stop after each name for you
to exchange garments.

1. On the control panel of the embroidery
machine, press the B key.

2. Choose Needle Bar Selection.

3. Enter the first color, press the RIGHT
Frame Arrow Key. This will insert a red
triangle to the bottom right of the needle
color.

4. Press SET.

5. Repeat until all colors are programmed for
the design with a stop afterwards. Or, if all
names are the same color, change the 2nd
needle color to a (-). This will force the
machine to start over at needle #1.

Sewing Process:

1. Place the first garment on the machine. Be
sure that you are on needle #1 and that the
needle is in the center of the hoop.

2. Trace the design to be sure that all names will
fit into the hoop you have chosen.

3. Start sewing the design. The first name in the
list will sew and when it is completed a 1B2 code
will come up on the control panel.

4. Remove the first garment from the machine,
place the second garment on the machine and
press start.

Don't re-position the hoop or you may hit it
with the needle!

Embroidery Machine Operations - TEJT NEOii Model

The embroidery machine must be
programmed to stop after each name for you
to exchange garments.

1. On the control panel of the embroidery
machine, choose NDL Bar Selection.

2. Choose Needle Bar Selection.

3. Enter the first color, press the STOP key.
This will insert a dash in the color sequence.
5. Repeat until all colors are programmed for
the design with a stop afterwards. Then,
press SET.

6. Or, if all names are the same color, press
SET after step 3. This will force the machine
to start over at needle #1.

Sewing Process:

1. Place the first garment on the machine. Be
sure that you are on needle #1 and that the
needle is in the center of the hoop.

2. Trace the design to be sure that all names will
fit into the hoop you have chosen.

3. Start sewing the design. The first name in the
list will sew and when it is completed a 1B2 code
will come up on the control panel.

4. Remove the first garment from the machine,
place the second garment on the machine and
press start.

Don't re-position the hoop or you may hit it
with the needle!




I Opening / Merging Designs

The Open command opens an existing (saved) file. You can open several different types of files with this feature. Each time that you
choose Open, another window is opened on your workspace.

The Merge Design command will make a copy of the selected design (existing saved design) and allow you to place the copy on your

current window. This is the most popular when working with existing designs because you can take many different files and place
them all in the same window thus creating one new file.

Both Open and Merge Design commands work with outline and stitch files.

To open an existing design:

1. click on File — Open.
2. Choose the desired file and left click on Open.

Edit Segment View Tools Imac

Mew
Open...

Merge Design

Save Ctrl+5
Save As,.,

Save As Copy...

Close

Print Preview

To merge an existing design:

1. Click on File > Merge Design.
2. Choose the desired file and left click on Open.

3. Then, left click once on your workspace to place the design.

File | Edit Segment View Tools Imac
Mew
Open...

Merge Design You must have a window

Save Ctrl+5S opened on your screen

Save As for the Merge Design
function to operate.
Save As Copy...




I Saving

Saving your design allows you to access the design in the future to use again or make changes.

You will want to save the design file twice —first in an outline format .PXF and second in a stitch format .DST.

There are many different ways to save a file:

SAVE: You can use this command if this is the first time that you are saving the design or if

FT) Bl St W you have edited the opened design and want to save the update.

[ew
open...
Merge Design

m made thereafter will not be saved in the original file.
] <

SAVE AS: You can use this command if you wish to save the open file as a different name or
as a different format. The new saved file is now current on your workspace. Any changes

SEVE s Copy.| L——— SAVE AS COPY: You can use this command if you wish to save the open file as a different
o=e name or as a different format. However it differs from the SAVE AS function in that it does

Frint Preview not open the new saved file on your screen.

Print...

Print Setup. .. EMBROIDERY DISK: You can use this function to start up a wizard that will walk you

Machine Connection N through the steps to saving or importing a .DST file that is on an external device such as a

< b floppy disk or flash drive.
Export g

You can READ from an embroidery disk which will open a design file from an external device
Delete Symbals, ..

onto your workspace; you can WRITE to an embroidery disk which will save a design file to

Design Properties, ., Shift+E an external device.

Recent Files r

Exit Alt+F4

Then you will have to choose the location to save the file, name and type of file.

I Savein: | Libraries v @@
,;“7 “&  Documents J) Music
Recent Places o e >
! ~ Pictures Videos
N/ Library > Library
Desktop y 4
e
Libraries
A
Computer
«@
Network
File name: [Design1| ¢ Save ’
Save as type: [Pulse Embroidery Files (*.PXF) V] l Cancel l




I Templates

Templates are a great way to speed up repetitive design creation. Any outline file can be used as a template file. Start with a

regular design, and then send it through the template function and.
Take this layout...

LOGO/
DESIGN

Supplemental Text

First, you must select or create the master file of which you will use
Then you can go through the template function (steps below).

1. Close all open files.

2. Goto New File > Templates.

Embroidery -

@ Blank Design & New Design Wizard

Wizards
‘é» Autodigitizer @ Stitch Image
Specialty Projects
Patches ‘ Templates l
3. Click OK.

Template Setting:

— Files

MNumber offiles:

N

Base file name:
@ Do not open files
TEMFL

— Laser

@ Open allfiles

@ Open firstfile

[T]Auto laser applique Order

[ |Resequence

OK ] | Cancel

4. Click OK.

..wala!
...to this!

for the template files. Save the master file as an outline .PXF.

esign File: Click on this Folder to

Design file:

|| = find the Master file you created
earlier.

Generation folder: eneration Folder: Click on this

| C:\Users\reebetD1\Documents Ey Folder to Send yOUT’ dESIQnS

created with the Template's

Then choose the Number of files
that you want to create and the
base file name. The files will be
sequentially numbered starting
with the base file name. For
example, TEMPL1, TEMPL2, etc.

| would choose to Open first file
or Do not open files if you are
creating more than a couple of
files at a time. This will keep the
software from freezing as it tries
to open all the files at once.




5. Youshould now have a window tab that reads Templatel with settings to adjust. As you can see all of the previous
information is still completely changeable here.
Under the Text boxes is where you can change the actual text that goes with each of the files that you are creating.
7. After you have made the changes you want, simply click on Generate Now.

Start Pagyv Templatel x]

Design file: Base file name:
C:\Users\reebet01\Droobox\HIC - Trainina\Chef.PXF & cook

Generation folder: @) Open all files
Ci\Users\reebet01\Documents ey (@) Open first file

@) Do not open files
Number of files:

" o) -

Auto laser applique

[]Resequence Text | Font | Height | Text | Font | Height

ChefBoyardee Block New 6.79 mm Cook off 2011 Block 1111 mm
ChefBoyardee Block New 6.79 mm Cook off 2011 Block 1111 mm

ChefBoyardee Block New 6.79 mm Cook off 2011 Block 1111 mm
ChefBoyardee Block New 6.79 mm Cook off 2011 Block 1111 mm

Here is a screen shot of the files together just created.

*Z} chef4. pxf - Normal - Tajima (Density: 63.5 spi, C: 7, S: 7640, W: 4.18.in, H: 3.... = (O}[X i chef2. pxf - Normal - Tajima (Density: 63.5 spi, C: 7,S: 7739, W: 4.181in, H: 3.... [ [0O[X]|
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‘:’Jcheflpr - Normal - Tajima (Density: 63.5 spi, C: 7, S: 7855, W: 4.18in, H: 3.... .77 =] ;( ’:‘.lcheﬁ.pr - Normal - Tajima (Density: 63.5 spi, C: 7,5: 7639, W: 4.18in,H: 3.... |- D §
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Make any necessary changes to spacing of the letters, etc. Be sure to resave that file afterwards as a .PXF.

You will have to save each file independently as a .DST.



TEMPLATES — CHANGE NAMES AND SIZES FOR ALL TEMFPLATES AT ONCE

All highlighted rows can be changed at once.

TEMPLATES — CHANGE NAMES AND SIZES FOR ALL TEMPLATES AT ONCE

B spege [© fenphied x (8 Buiied | L5 EMREed | B TEWREp | -
Disgn fe e file name

[ hared Docem ents P alchesy,Crginal Fig AR S RIF =3 TiWPL
Genetation 1 ploer & Cpen ol il

e s Desteph Tenplis [ ipen et file

= Do st open ks

Mermberef fins

3

Aunte lasei appliqus

Bepageence
Drden 12 0hem
0 m @Mm
icenerme now ]

W el liboe T B aatiber ceieles i Bl . iwai it Dee e i Tl Peoida) anndion < haimgs gize of

I— sebectzadhighlighted rows i HElait row (i one shot
TEMPLATES — CHANGE FONT FOR ALL TEMPLATES AT ONCE

All highlighted rows can be changed at once.

B ctartPage [§ Templatel

Design file: Bace file name:
DShared Documenty Tajimes Problems\Problems by AledSigramihghaslar Schablone P 15 TEMEL
Generaten folden 1 Open ol files
Chllzersyuser Decktop' Template 7] 7 Cipen fiest file
& Do not apen hles
Humber of files
[[] Auto lsser 2pplique
Fessquends Tem Hesght
— b+ Dy Nesarriarr [ =§&Qam
e (Ciamy Measrann Hew & Omm
Dy Memaranr Hew & Dmm
emerale now Dy Neasrann & Omm
Dy hlewsranm Hew 8 Dwm

Highlight all er individual Font rows and select a
different Font should apply to all highlighted rows




I Production Worksheet

The Print Preview function in Tajima DG/ML by Pulse products a production worksheet. Here you will have important information
about your design documented for future reference.

On the Production Worksheet, you can input valuable information like the design dimensions, color changes for the machine
operator and cost of the design.

Below is a sample Production Worksheet:

Hirsch International Corp
Design: Mew'ear2003 Dimension: W32%inx H3000n
Stitches: 6631 Color changes: 3

Headlk 1 i Hezdk 2 3 Hezdk 3 n Headlle &

[ zontpeacs [ wantcray [ Flame Rea [ Goke i

10ia 1085 ‘ 15 _d 1S

Mk 13 40 MFEIR 40 MK IR 40 Mz 13 40

a2t 10514 1280 142"

S, (2R T F, 56 SHLEE, (1540 405 . (1945
3 Heedlk 5 Headlk & F Heedk 7 Headlk 5

W MEnitE e I gk Green [ Pobh Eqg Be W MEitEne

4 |z 1249 A 106G 124z

Mack 13 40 Mk 4 Mak I 43 Mack 13 40

el 152401 " 29457 I

[E il Tk 1034 3. GHT (TVES G T BT
7 Heaclk 1

[ sottpeack

10ia

Mack 3 40

65"

3 =N ]

To View: Menu Ribbon File > Print Preview
To Change what prints: Settings in Print Preview
To change your company name and estimate cost: Menu Ribbon Tools > Configuration > User Settings > User Preferences Tab

To change design notes & your customer’s name: Menu Ribbon File > Design Properties



I Quotation Estimator Wizard

The Quotation Estimator is a software feature that guides you through the creation a customized Quote Sheet to give to your
customer for approval of the image on a garment along with pricing and promised date. To start the Wizard, click on Tools >
Quotation Estimator Wizard.

1. Thefirst step is choosing the design for the customer. Click on the Folder to select the embroidery file to use. The software
will automatically generate a jpg thumbnail for the design and place it on your Quote. Click Next.

2. The view/edit design statistics will be shown for the design. This will include the stitch count, trims and colors. You can
change this is you want or you can leave it. Click Next to continue.

3. Youcan set the machine speed, as well as the number of heads that you run in your shop. This will affect the time per item
to create on the Quote. Click Next.

4. You can set the pricing either by a number of stitches or by a fixed amount. You can even set the cost for material and
digitizing as well. Click Next.
Set customer details is where you input all your customer contact information for record keeping. Click Next.

6. Set print settings will let you show your company logo and choose what information is shown on the printed quote. This is
also where you choose the delivery date of your product. Click Next.

7. Simulation Background: choose the garment or similar style garment to that which the customer is ordering for a more
realistic view of the embroidery design. Click Next.
Simulation placement: click and drag the logo to the desired place on the garment.
Quotation preview lets you see the quote before you print it. Click finish to print.

QUOTATION ESTIMATOR — ROTATE DESIGN IN QUOTATION ESTIMATOR

Users can rotate the 3D design image within the Quotation Estimator.

This helps with garments like towels where the design is intended to be in a corner or at an angle.

QUOTATION ESTIMATOR — STORE INFORMATION IN QUOTATION ESTIMATOR

This feature allows the user to pre-populate information from previously entered/stored customer data.



PRINTING — PRINT INDIVIDUAL FONT CHARACTERS

DG15 has implemented the ability to print the individual letters included in fonts.
This is for use in printed books that users can show their customers to demonstrate font selection.

File = Print = Print Preview > Print Setup

ATHL 3150 - Ve Dy %

]
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\\\\\

View > Unicode = Character > No Label



PRINTING — PRINT DESIGN ONLY

An option has been added to print a design only, meaning that no additional information will appear on
the printed page.

Users can select what information appears via a checkbox

Settings = Print > Worksheets

PRINTING — ADD INFORMATION TO PRINT OUT

When the setting is enabled, information is displayed in the print out showing the distance between the

start and end location in a design.

This is an easy way for users to check location for AFC machine.

Origin x (mmj: -0 +§4
Origin y (mrh): -184 +0
Start/ End distance (mm): 184 mm



4.7.2 Create a Monogram

Create a Monogram is a new feature that allows you to very easily create simple or
elaborate monogram designs. To use the Create a Monogram feature, open the New
Document dialog (Ctrl + N, or File—MNew), and select the Monogram specialty project. The
Monogram dialeg will then open in a separate window.
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The Create a Monogram dialog presents the user with a list of monogram layouts, from one
to three letters, in the column on the left. When you select the monogram in the preview
window the monogram properties panel appears on the right. Enter the letters, select the
font, color, and lettering height and click the Apply to see a preview. Click OK to generate
the design in the workspace.

Create a Monogram Options:

Frames: There are a large number of embroidery frame available in the Create a Monogram
dialog. A "default™ décor will appear in the Create a Monogram window. When you select a
different frame, the new selection appears in the Create a Monogram preview

Decors: You can also adds small embellishments to the monogram in the Create a
Monogram dialeg. There are a set of placeholders that appear around the monogram letters
(top/bottom, left and right sides, and at the corners); select any of these, and then select
an embellishment from the list on the right.

Save Template/Open Template: This is a way to speed up the creation of a number very
similar monograms, by creating a reusable pattern, or template. For example, if you are
going to make some designs that have exactly the same frame, or pattern of decors, but
with different initials in the middle. Select the monogram style, font, decors and/for frame,
and then click the Save Template button. This will open a Save as dialog, which allows you
save the monogram as a generic Template. Then, when you want to make a new
monogram, click the Open Template button and change only the letters.

Product level availability: Composer



8 Cloud Storage

Tajima DG15 by Pulse now offers the ability to save designs to cloud storage directly from
within the software. You can send to and retrieve files from Dropbox and/or Pulse Cloud
from the File menu. Additionally, Pulse Cloud has many other features, such as design
tagging, access to web apps, and the ability to view the design queues remotely.

8.1 Pulse Cloud

Pulse Cloud iz a new service that enables you to manage your designs and machines
remotely, through either a computer or mobile device. This web-based service allows easy
storage and sharing of designs from your Tajima DG15 computer, and downloading of
shared designs onto your computer,

Registration is required to use Pulse Cloud; while registering, you will create your own
user ID and password.

| ' | When you Share with or Open from Pulse Cloud from within DG 15 by Pulse, you will
imitially be linked cut o a sign-in page. which will required this usemame and password
o before you can open or save designs: however, you can apt to remain signed in for sub-

sequent writing to'reading from Pulse Cloud.

Sharing designs: In DG15 by Pulse, select File—Share with—Fulse Cloud. (The first time,
you will be prompted by a dialog for permission to write to the Pulse Cloud disk — click
"Allow™). You will then see a Save as dialog, which will show the names, number of stitches,
and file size of any files already in storage.

Sawe Fle = .
PubeCid
Mama Mum. sitchas Size Canca |

artishas PYXF 90235 GARIE0
__| column underkay FIF 31 14248 [ Mew Folder ]
Ard of Paradse, FiF 11755 118489
File pamea:
d=sign2. PYF

™ S

If required, enter a new name into the File name field and click Save. The new file will now
be uploaded onto Pulse Cloud storaged.



Opening designs: In DG15 by Pulse, select File—Open from—Pulse Cloud. You see an
Cpen dialog. Click on the name of the design form this the list to select it. {If "show
thumbnail” is selected, a thumbnail preview of the image will appear in the dialog.)

Click Open, and the design will appear in the workspace. Notice that in the name tab (along
the top of the workspace) the design’s name has "Pulse Cloud”™ appended to it. This signifies
that it is not a local copy; you can create a local copy, by using the "Save as” command.

Functions available on the Pulse Cloud web site:

Tagging: This i= a another advantage to using Pulse Cloud for design storage. On
cloud.pulsemicro.com, designs can have tags assigned to them in, which allows you to do
filtered searches. When design is tagged with keywords, you can click on the tag in the
"Designs” page of your PulseCloud page, and it will show only the designs that are tagged
with that keyword.

* To create a tag: On the "Files” page, click on the Create New tag link, and input the
tag text into the field.

* To assign a tag: Double-click on a design name in the list, which will open the
information page for that individual desian. Click the Tag tab, and check the boxes of
the tags you want to assign to the design.

pulsecloudfl * & i
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Design statistics: On Pulse Cloud, information about the design is readily viewable from
yvour device — the number of stitches, overall dimensions, file size, and creation date.

Machine status: On your Pulse Cloud account, if it is configured it so that your design
spoolers are synched with it, vou can see machine status live on line - for example, see
what is currently sewing, what designs are in the queue, and track machine events, such as
thread breaks.

Send to machine: If you have a design spooler linked to your Pulse Cloud account, vou will
be able to send uploaded designs to the machines on the spooler from any device on the
web.

Applications: & Pulse Cloud account allows you to work with web applications, such as
variable data.



8 PulseCloud Features
8.1 Mass Upload Wizard

The "Mass Upload to PulseCloud” wizard has been added to make uploading of design files
to the PulseCloud server go more quickly. This feature manages the uploading of as many
files as you want to your PulseCloud storage, all in a single operation. The wizard allows you
to select and upload multiple files, either from your hard drive (or other connected storage
device) or from your own Librarian database.

Important note: Since the PulseCloud environment only accepts *.PXF (Pulse outline) files,
any non-*.PXF files that you want to import will be automatically converted to *.PXF during

the upload process. The "Mass Upload to PulseCloud” wizard E tool may be found on the
Ribbon—Processing tab.

Product level availability: All

8.2 Save to or Open files from Drophox
Tajima DG15 by Pulse allows you to read or save files to your existing Dropbox Account.

Saving Designs: In Tajima DG15 by Pulse select File-Share-Dropbox; a Dropbox sign-in
dialog will open in a new window. After you sign in to your account you can save the file to
your Dropbox account.

Opening Designs: In Tajima DG15 by Pulse Select File-Open From-Dropbox to open a
Dropbox sign-in dialog. You can then download any design file saved on you Dropbox.

Product level availability: Composer

8 PulseCloud Features
8.1 Mass Upload Wizard

The "Mass Upload to PulseCloud” wizard has been added to make uploading of design files
to the PulseCloud server go more quickly. This feature manages the uploading of as many
files as you want to your PulseCloud storage, all in a single operation. The wizard allows you
to select and upload multiple files, either from your hard drive (or other connected storage
device) or from your own Librarian database.

Important note: Since the PulseCloud environment only accepts *.PXF (Pulse outline) files,
any non-*.PXF files that you want to import will be automatically converted to *.PXF during

the upload process. The "Mass Upload to PulseCloud” wizard F” tool may be found on the
Ribbon—Processing tab.

Product level availability: All



Hide fonts

The complete list of fonts available in Tajima DG17 by Pulse is very long so it can take a while to look through them all. To
save time while scrolling through the list when selecting a font, it is now possible to choose to display only the list of new-style
fonts.

To change this setting, go to Tools—Configuration— User Settings — Customize—Text; select “Display all fonts” to show both
old and new styles, or select “Hide old fonts” to display only the new-style fonts.

The following table displays the new fonts that have been added to Tajima DG17; note that
these are now included as standard fonts.

Block Black

Block Black

Edgy

Madison New

Madison New

efeoreid

Meteoriod

Portfolio

Portfolio

In addition to the new fonts listed above, these previously optional fonts have now been
added to the list of Standard fonts in Tajima DG17.

* Global
e Keep Calm
e Snow New
Product level availability: All



I Homework Assignment #1

Let’s review how to create the first homework assignment.

On the Production Worksheet, it told us some very important information; like the design colors, location and the fabric type. These
are all key elements of any order and once we know this information, we can begin creating the design.

Objectives: Create a design for the front of a cap.

- Startanew file.

- Choose arecipe.

- Merge an outline file.

- Add lettering.

- Save thefile in an outline format (PXF).

- Re—Save the file in a stitch format (DST).

Instructions:
1. Start with a new file.
2. Choose the appropriate recipe - CAP.
3. Click OK.
4. Go to File and choose Merge Design.
5.  Remember that you can click on Icons to preview the designs in the folder.
6. Choose the design that looks like the balls & bats one in this design.
7. Click on Open.
8. Left click once to place the design on your workspace.
9. You will have to resize the design smaller in order to add text to the design and have it still fit onto the cap.
10. You should still be selected on the design, if not, left click and drag a box completely around the design.
11. Left click and drag one of the 4 corners —look at the bottom of the screen as you drag to see the new dimensions.
12. Let go whenyou are at 1.75 inches.
13. Now, choose the Arc lettering tool.
14. Left click to get started, move the mouse over and left click again to set the length.
15. Now move the mouse up to set the radius or curvature of the baseline. Remember this is the line that the text will sit on.

It's ok if it’s not exactly lined up over the design, because we will adjust it later.

16. Left click to set the radius.

17. Move the mouse up again for the height of the lettering.

18. Left click to set the height —0.25 inches.

19. Typein the text — Little League.

20. Left click OK.

21. Change the font to Brantford New.

22. Now you can drag to move the text centered over the design.

23. Save the file as a PXF and DST.

24. Your design size should be the same as on the Production Worksheet. At this time, don’t compare the stitch count because
we’ve not covered how to adjust the Embroidery Principals for designs.



Dimension: W 2.65in x H 2.07 in Stitches: 3297

Page 1of 1
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Origin x ("): -1.30 +1.30 Origin y ("): -1.02 +1.02 CAP DESIGN BRANTFORD FONT
.25 IN TALL WILL NEED TO RESIZE
DESIGN 444
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I Homework Assignment #2

Objectives: Create a design for the front of a T — Shirt.

- Startanew file.

- Choose arecipe.

- Merge an outline file.

- Add lettering.

- Save the file in an outline format (PXF).

- Re—Save the file in a stitch format (DST).

Instructions:

First we start off with a new file.

Choose a recipe — T-Shirt.

Left click OK.

Next, let’s import our design.

Left click on File — choose Merge Design.

This design will be located in the Animals folder. Remember you can left click on the Icons button.
Open the design.

Left click to place it on your workspace.

L X N Uk WM R

You won’t have to resize this design because the sewable area is large enough to fit the design with the text.

=
o

. Choose the Line Angle Lettering tool.

[
[N

. Left click to get started creating the baseline.

=
N

. Move the mouse across and left click to set the length.

=
w

. Now, move the mouse up to set the height - .50inches.

=
D

. Left click to confirm height.

[ER
u

. Choose the multiline button.

[uny
o)}

. Type ‘You Belong'.

[y
~

. Hit (Enter) to move to the next line.

=
0o

. Type ‘inthe’.

=
o

. Hit (Enter) to move to the next line.

N
o

. Type ‘Atlanta Zoo'.

. Left click on OK.

. Change the font to Hobo New.

. Change the Text Justify to Left.

. Now just drag the text under the neck of the giraffe.

N N NN
A W N P



Dimension: W4.02inx H 2.30 in Stitches: 6265
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